KeyWallPRO QuickStart Guide
- Simple Wall Design -

This QuickStart guide is an introduction to preparing a simple wall design. KeyWallPRO is a powerful design program with numerous features so the User should utilize the Help files and experimentation to learn about all the features and options prior to preparing estimates and designs.

**New Full Wall Design** is selected from the **New Project** listing under the **File** menu.

This guide assumes the User has reviewed the File Management and Saving Guide to set up a project backup path and can fill in the appropriate client, project name, backup path, etc. information during this process.

The following steps are the simplest and fastest way to generate a wall design without addressing the many setting and variations that KeyWallPRO allows. Preliminary design estimates and final wall designs in the real world require complying with specifications, design methodologies, and more complex design situations than a simple example can address.

1. **Step 1 - Review Program Options and Settings.**
2. **Step 2 - Select Design Methodology and Create Wall.**
3. **Step 3 - Review Empirical Design Criteria.**
4. **Step 4 - Select Keystone Wall Unit and Batter.**
5. **Step 5 - Select Soil Reinforcement and Parameters.**
6. **Step 6 - Enter Extreme Event criteria.**
7. **Step 7 - Enter Top and Bottom Wall Geometry.**
8. **Step 8 - Review and Modify Wall Panel Layout if needed.**
9. **Step 9 - Add Slope or Surcharge Loading Conditions as needed to any or all sections.**
10. **Step 10 - Generate and Review Trial Wall Design.**
11. **Step 11 - Generate Printout of Quantities and Calculations.**

The Simple Wall Design is intended to show the basic steps necessary to perform a simple wall design. Every program tab permits modification to many parts of the design and geometrical layout so walls in practice may be considerably more complicated than this simple example.
Step 1 - Review Program Options and Settings

Reviewing the KeyWallPRO Options is a good place to start when first using the software prior to designing a wall. These global settings apply to all wall designs generated by KeyWallPRO and should be set at the beginning of program use although they can be changed at any time.

1. Select **Options** from the **Settings** drop-down menu list.
2. Review the various options under the tabs prior to program use.

Step 2 - Select Design Methodology & Create Wall

A design methodology is the User's choice but can be mandated by project requirements. Each design methodology has its own requirements and methods so the answers will be different for each method for the same retaining wall. The User should become familiar with each methodology before selection to understand the benefits and limitations of each.

3. Select a design methodology from the **Methodology** drop-down menu list (NCMA selected in this example)
4. Press the **Create Wall** button.
5. Enter name or number of wall in the dialog box and press the **OK** button. Wall names or numbers will be listed along the top of program window for easy access.
Step 3 - Review Empirical Design Criteria

**Design Criteria** can be modified for each wall and reflects both empirical design criteria as well as factors of safety and load/resistance factors depending on design methodology.

The empirical criteria is the most useful to review since they control aspects of the wall and reinforcement layout that would be of most interest to the wall designer. The example below looks at the empirical criteria for the Reinforced Analysis and Common Criteria for the selected wall under NCMA criteria for this example.

1. Select the **Design Criteria** tab then the **Reinforced Analysis** type and **Empirical Checks**.
2. Review and edit the reinforcement spacing criteria as needed.
   - Max. Reinforcement Separation limits reinforcement spacing between levels (ft.).
   - Max. multiple of Hu limits reinforcement spacing from the top and bottom of wall in block height increments (no. of blocks).
3. Review and edit the reinforcement length criteria as needed.
   - Min. anchorage length is the minimum distance beyond failure plane (ft.).
   - Min L/H ratio is the minimum base to height ratio regardless of calculation (ratio)
   - Min. reinforcement length is the minimum length regardless of calculation (ft.)
4. Select the **Common Criteria** type and **Empirical Checks** (criteria applies to reinforced or gravity walls).
5. Review and edit the minimum embedment criteria criteria as needed.
Step 4 - Select Unit Type

The Wall Unit tab is for selecting the appropriate Keystone unit for the wall design. The User should have knowledge of locally available Keystone products and the appropriateness of selected products for a given project’s structural and aesthetic requirements.

Under the Unit Type tab, Keystone units can be selected first from the Product Line dropdown menu box that defines the product type and then from the Units dropdown menu box which provides a list of possible products for that product line included in the software data file.

The Wall Unit tab allows the User to define wall batter for variable batter system and also specify the capping size on top of the wall. Design information is provided after the unit is selected. There is also an option to define leveling pad dimension and top of wall alignment that will not be addressed.

1. Select Product Line and select Keystone Pinned Systems for this example.
2. Select Wall Unit and select Compac III unit.
3. Leave Cap Height set at Half Height default.
4. Leave Fascia Batter set at 8˚ default.
5. Leave other items at defaults shown.
Step 5 - Select ReinforcementType

The Reinforcement tab is for selecting the appropriate soil reinforcement that goes with the selected Keystone unit for the wall design. The User should have knowledge of locally available geosynthetic products and the appropriateness of selected products for a given project's geotechnical and structural requirements.

Under the Reinforcement tab, a geosynthetic supplier/manufacturer can be selected from the Suppliers dropdown menu box. Then the products tested with the Wall Units selected previously will be presented in the Available Products listing. One or more products can be selected for use in the wall by double-clicking on the selection or using the arrow buttons.

After the Reinforcement and the Soil Category are selected, the design parameters are filled in on the remainder of the screen.

1. Select Supplier dropdown menu and select TenCate Mirafi - Miragrid for this example.
2. Select 3XT - Miragrid 3XT from the product listing.
3. Double-click or press arrow key to move 3XT - Miragrid 3XT to be "Used in this wall".
4. Select the Soil Category dropdown menu and select Sands as the reinforced fill material type to establish an appropriate installation damage value, RFid, based on typical values.
5. Review the Generation Increment setting. This value is used in the design process for the length increment between section designs, 1' or 2' are common increments.
Step 6 - Set Soil Condition Parameters

The **Soil Conditions** tab is for inputting the appropriate soil design properties for use in the analysis. The User should have knowledge of project soil conditions and proposed backfill materials. The **Soil Conditions** tab also allows for the optional definition of basic wall drainage elements and calculates neat quantities that is not part of this simplified example.

The User will enter the appropriate effective stress parameters for the zones defined in the input table and can add descriptions as needed.

1. Enter the friction angle (ϕ angle) for the reinforced, retained, and foundation soil zones, 30° used in this example.
2. Enter the in-place unit weight (γ) for the reinforced, retained, and foundation soil zones, 120 pcf used in this example.
3. Leveling pad material properties are only used for gravity wall design and can be ignored in this example.
4. Soil description will not be added in this example.
Step 7 - Extreme Events

The Extreme Events tab is for inputting seismic parameters and will be ignored in this simple example.

Step 8 - Stations & Elevations

The Stations tab is for inputting top and bottom wall stations and elevations from which KeyWallPRO will calculate the wall envelope required to meet the design requirements. An outline preview is shown in the window below also.

1. Enter the top of wall station and finished grade elevations taken from the wall alignment and grading. In this example, the top slopes up from El 100 to El 110 over 100 feet.
2. Enter the bottom of wall station and finished grade elevations taken from the wall alignment and grading. In this example, the bottom is level at El 100 over the 100’ length.

Note: The beginning and end stations for the top and bottom of wall must match before leaving this screen or the program will not proceed.
Step 9 - Panelization

The Panels tab is where KeyWallPRO creates the block layout necessary to meet the geometrical requirements of the design. The trial wall profile will automatically be generated upon selecting this tab. The User has control in this screen to re-layout the wall by varying parameters or manually adjusting individual panels.

This first wall elevation below is generated based on the design criteria settings and the default selection for caps not being included in the profile generation. The second wall elevation has been generated by:

1. Changing the Min. Embedment to 1.0’.
2. Checking Include Cap in Height for a more efficient layout.
3. Pressing Generate which creates a new profile based on a different top of wall datum and embedment criteria that will be used for the rest of sample design.
Step 10 - Loading Conditions

The **Loading Conditions** tab is for adding back slopes and surcharges to each wall section. KeyWallPRO permits the offsetting of slopes and surcharges which provides considerable flexibility for the User to model specific site conditions at every location along a wall.

For this example, a typical 50 psf live load will be applied to a level backslope for all wall sections. The procedure is as follows:

1. Select any wall section in section or elevation windows.
2. Select **Live Load**, enter a value of 50 psf, and Tab to next cell. Wall section should show load arrows behind facing.
3. Press the **Apply To All** button which will copy the selected section's loading conditions to all other wall sections.
4. Elevation view now shows load arrows on top of all sections.

Note: Each section can have its own loading condition and be input individually. Controls are provided to speed up this process for copying to adjacent sections.
Step 11 - Design Generation

The **Design** tab is where the reinforcement design generation and analysis takes place. KeyWallPRO will perform a trial generation based on the **Design Criteria** spacing criteria and the reinforcement type and increment specified in the **Reinforcement** tab.

For this example, a trial generation will be done from the information previously input.

1. Press the **Generate All** button and KeyWallPRO will attempt to generate a design for all wall sections based on the criteria previously entered or use default values.
2. Review the **Elevation View** looking for any "Red" sections that would indicate an analysis failure of any of the design criteria. All sections are green in this simple wall generation which means the design meets the minimum design criteria.
3. Select the tallest section in the elevation view. The design section is shown in the **Section View** window and the reinforcement length is determined based the 1.0' length increment.
4. The **Quick Results** displays a results summary for the section selected. Any design criteria failures can be located in this listing and the design modified to satisfy the requirements.

Note: The Design tab has many features for controlling the design generation and analysis that are beyond the scope of this simple wall design. Please review the Help file for further explanation of buttons, check boxes, and input values.
Step 12 - Printout Results

When the wall design is complete, a printout of the quantities and selected design section summaries is typically required by the User.

1. **Select PDF Report** from **File** menu.
2. Select Section(s) from the **Wall/Sections** window. (Control-Click to select multiple sections)
3. Select **Summary Report** check boxes desired.
4. Press **Preview/Print** button.